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1
Introduction
The ZebraLink Enterprise Connector (ZEC) has the ability to efficiently interpret and convert 
XML into printable content, which translates into time and cost savings for bar code label 
printing and RFID encoding. 

ZEC offers the following benefits:

• Preloaded label formats, which provide the fastest way to start printing bar codes and 
labels without having to know the Zebra Programming Language II (ZPL II®). The 
preloaded label formats support Oracle® WMS, Oracle Depot Repair, and Oracle BI 
Publisher, facilitating XML printing from these Oracle applications.

• Label printing from Oracle BI Publisher to Zebra ZPL II printers.

• A simple, convenient interface for printing labels with text, graphics, or bar codes or for 
encoding RFID tags.

• Efficient use of resources by building a single labeling solution that can be used to print 
multiple languages thanks to Unicode support in Zebra printers.

ZEC is supported on the following operating systems:

• Red Hat® Enterprise Linux® ES release 4

• HP-UX™ 11iV1 (B.11.11)

For information specific to JD Edwards EnterpriseOne users, refer to Appendix D on page 125.
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8

ZEC and Oracle BI Publisher

BI Publisher is Oracle’s solution for accepting data from a variety of sources and transforming 
them into printable data for transmission to the desired output device. ZEC works with 
BI Publisher to transform incoming data into printable label content, allowing Oracle System 
Integrators to leverage BI Publisher for all thermal barcode output print jobs. 

Figure 1 • ZebraLink Enterprise Connector Printing

The ZebraLink Enterprise Connector printing solution includes the following components:

• ZebraLink Enterprise Connector—the server-based solution that is run using the Java  
Runtime Environment (v1.4 or greater). ZEC uses XML-formatted data, which allows for 
easy implementation of custom designs and ZPL delivery to any Zebra ZPL II printer.

• ZebraNet™ Bridge Enterprise—a printer management tool for setting alerts, audits and 
configurations. See ZebraNet Bridge Enterprise  on page 49.

• ZebraDesigner™ for XML—a software package that gives you the ability to create label 
formats in a GUI environment. See ZebraDesigner for XML on page 25.

• Zebra printers—ZEC can be used with a broad range of Zebra printers, including the 
following:

• 105SL™

• G-Series™ (GX™, GK™)

• P4T™ and RP4T™

• QL Plus™ series (QL 220 Plus™, QL 320 Plus™, QL 420 Plus™)

• PAX4™ series (110PAX4™, 170PAX4™)

• R110PAX4™
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• RXi™ series (R110Xi, R170Xi)

• RW™ series (RW420™, RW220™)

• RZ™ series (RZ400, RZ600)

• S4M™

• Xi™ series (110XiIIIPlus™, 140XiIIIPlus™, 170XiIIIPlus™, 220XiIIIPlus™)

• Xi4™ series (110Xi4™, 140Xi4™, 170Xi4™, 220Xi4™)

• Z Series® (ZM400, ZM600, Z4Mplus, Z6Mplus)

How ZEC Works
The following example shows how XML data is merged into a ZPL label template by the 
ZebraLink Enterprise Connector. The resulting labels follow. 

For illustration purposes in the example, the following conventions are used:

• The report name is shown in blue.

• Variable names and data are shown in bold.

• Individual labels to be printed are contained with the <RECORD> and </RECORD> 
XML tags.

  <?xml version="1.0" encoding="UTF-8" ?> 
  <!--  Generated by Oracle Reports version 6.0.8.27.0   --> 
  <SHIP_TO_RECORD_SET>
    <FROM_NAME>Zebra Technologies</FROM_NAME> 
    <FROM_STREET>333 Corporate Woods Pkwy</FROM_STREET> 
    <FROM_CITYSTATEZIP>Vernon Hills, IL 60061</FROM_CITYSTATEZIP> 
     <RECORD>
       <TO_NAME>Acme Processing</TO_NAME> 
       <TO_STREET>1280 Industrial Ave</TO_STREET> 
       <TO_CITYSTATEZIP>Planesville, IL 60046</TO_CITYSTATEZIP> 
     </RECORD>
     <RECORD>
       <TO_NAME>Omni Corporate Packaging</TO_NAME> 
       <TO_STREET>46 Delta Street</TO_STREET> 
       <TO_CITYSTATEZIP>Detroit, MI 48226</TO_CITYSTATEZIP> 
     </RECORD>
  </SHIP_TO_RECORD_SET>

Incoming XML Data Stream  

^XA
^FO050,050^A0N,30,30^FN1^FD$$FROM_NAME$$^FS
^FO050,080^A0N,30,30^FN2^FD$$FROM_STREET$$^FS
^FO050,110^A0N,30,30^FN3^FD$$FROM_CITYSTATEZIP$$^FS
^FO150,250^A0N,50,50^FN4^FD$$TO_NAME$$^FS
^FO150,300^A0N,50,50^FN5^FD$$TO_STREET$$^FS
^FO150,350^A0N,50,50^FN6^FD$$TO_CITYSTATEZIP$$^FS
^FO150,450^BCN,100,N^FN7^FD$$TO_NAME$$^FS
^XZ

ZPL Template (using template file AddressLabel.zpl)  
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^XA
^FO050,050^A0N,30,30^FN1^FDZebra Technologies^FS
^FO050,080^A0N,30,30^FN2^FD333 Corporate Woods Pkwy^FS
^FO050,110^A0N,30,30^FN3^FDVernon Hills, IL 60061^FS
^FO150,250^A0N,50,50^FN4^FDAcme Processing^FS
^FO150,300^A0N,50,50^FN5^FD1280 Industrial Ave^FS
^FO150,350^A0N,50,50^FN6^FDPlanesville, IL 60046^FS
^FO150,450^BCN,100,N^FN7^FDAcme Processing^FS
^XZ
^XA^IDR:*.GRF^FS
^XZ
^XA
^FO050,050^A0N,30,30^FN1^FDZebra Technologies^FS
^FO050,080^A0N,30,30^FN2^FD333 Corporate Woods Pkwy^FS
^FO050,110^A0N,30,30^FN3^FDVernon Hills, IL 60061^FS
^FO150,250^A0N,50,50^FN4^FDOmni Corporate Packaging^FS
^FO150,300^A0N,50,50^FN5^FD46 Delta Street^FS
^FO150,350^A0N,50,50^FN6^FDDetroit, MI 48226^FS
^FO150,450^BCN,100,N^FN7^FDOmni Corporate Packaging^FS
^XZ
^XA^IDR:*.GRF^FS
^XZ

Resulting ZPL Sent to Printer  

Resulting Labels  
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2
ZEC Installation and 

Operation
The ZebraLink Enterprise Connector installs in the unlicensed Demo mode. To operate in the 
full, licensed mode, you must obtain a license file from your Authorized Zebra Reseller. 

Important • The server on which ZebraLink Enterprise Connector is to be licensed must 
have a static IP address. To minimize the information that you need to provide during 
licensing, perform the licensing procedure from the server where the program will be run.
09/29/2011 ZebraLink™ Enterprise Connector User Guide P1006951-002 A



ZEC Installation and Operation
Installing ZEC

12
Installing ZEC

The ZebraLink Enterprise Connector is a Java application that runs within the Java Runtime 
Environment (v1.4 or greater). You can run the installation file (zecinstall.bin) from 
any location on the Oracle application server. 

To install the ZebraLink Enterprise Connector, complete these steps:

1. Run the installation file from the command prompt by typing:

%> ./zecinstall.bin

2. Press Enter.

The End User License Agreement is displayed.

3. Read the license agreement. 
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4. Press Enter to advance through the license agreement screens.

At the end of the license agreement, you are prompted to accept the terms.

5. To accept the license agreement, type Y and then press Enter.

The default installation path is /opt/zebra_ec. You can accept this path or you may 
specify your own absolute path.

6. If desired, enter another path.
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7. Press Enter.

The installation information is displayed.

8. Press Enter.

The installer begins the installation process.

During installation, the following directories are created in the <install_path> 
directory:

• Uninstall_Enterprise_Connector (files for uninstalling ZEC)

• bin (contains the ZEC program and configuration files)

• tmp (a temporary storage directory)

• documentation (contains the User Guide)

• Licenses (contains the end user license agreements for the product)

• installlog (contains the install record)

• logging (contains event logs)

• xmlreports (contains stored XML data streams)

• xsl (contains XSL transforms)

• zplrepository (contains stored label templates)

The Enterprise Connector installation process is completed after the “Installation 
Complete” confirmation message. 
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9. Press Enter to exit.

Important • The installer creates the installation directory and corresponding files with 
the owner and group set to the user who is installing the product.

ZebraLink Enterprise Connector is installed with the assumption that a specific group will 
be created for users or processes that only need to print. Most files are configured such 
that the permissions only allow the group or other users to read the file. The 
<install_path>/bin/zec and <install_path>/bin/zecPipe files and the 
<install_path>/tmp folder are configured to allow the group the proper 
permissions to print.

To change the group of every file in the installation, type the following:

%> chown -R :<group_name> <install_path>
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Licensing ZEC

ZEC is installed in Demo mode by default. The software stays in Demo mode until the 
administrator loads a valid license file (license.lic) in a specified directory 
(<install_path>/bin). 

To use ZEC for production purposes, you must purchase a valid software license from Zebra 
Technologies or from a certified Zebra Value Added Reseller. For additional information 
regarding ZEC licensing, send an e-mail to connector@zebra.com.

Demo Mode

In Demo mode, the word “DEMO” is printed in the upper-left corner of the label, and the 
following characters are replaced in variable field data:

• “E” with a random letter

• “e” with a random letter

• “I” with a random letter

• “i” with a random letter

• “2” with a random number

• “7” with a random number

License Mode

To activate the ZEC for production purposes, you must obtain and install a license file. The 
ZEC licensing system uses data about the computer that it is being run on to validate its 
license. A “token file” that you generate contains the necessary data.

To obtain a license file, you must create a token file and send it in with your order. When the 
order is validated, the license file is generated and sent to you via e-mail.

Important • If a valid ZEC license file is modified in any way, ZEC will no longer recognize 
it as valid and will revert to running in Demo mode.
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To generate the token file, complete these steps:

1. Navigate to the bin subdirectory of the ZEC installation directory.

2. Execute the following command from within the bin subdirectory, substituting your data 
for the information in quotation marks. You do not need to specify the IP address and host 
name unless the server has multiple host names and/or network interfaces. 

./zec -t "CustomerName" "ReceiptNumber" ["ipAddress" "HostName"] 

where

• CustomerName = your company name

• ReceiptNumber = a number (such as a purchase order number) that is meaningful 
to you or your company

• ipAddress = the IP address of the server where ZEC is installed (required only for 
a server with multiple host names and/or network interfaces)

• HostName = the name of the server where ZEC is installed (required only for a 
server with multiple host names and/or network interfaces)

Using the information that you provide, this command generates a token file named:

CustomerName_ReceiptNumber.info

3. Place your order for the ZEC license, including the .info file with your order.

Upon receipt of your order and the .info file, Zebra generates a license file named 
license.lic and e-mails it to you.

4. Place the file license.lic in the bin directory. Do not rename the file.

If the license file is valid for the server, the next print job runs in Licensed mode.

5. If desired, send the following command to verify that ZEC is running in Licensed mode:

./zec -l

Note • The loopback IP address and “localhost” are not valid for use when creating 
the token file.

Examples • The following commands result in files with the names shown. For 
example:

./zec -t "Zebra Technologies" "Server1" 

results in a file called Zebra Technologies_Server1.info.

And

./zec -t "Zebra" "123 HG" "10.3.4.55" "THX1138" 

results in a file called Zebra_123 HG.info.

Important • The .info file must be created using the IP address and host name of the 
computer where ZEC will be used during production. If either the IP address or host name 
changes at any time, ZEC will no longer recognize that license as valid and will 
automatically revert to Demo mode. For help, send an e-mail to connector@zebra.com.
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Running ZEC

This section shows the ZEC options that you may run from the command line. Arguments in 
brackets are optional.

Note • The ZebraLink Enterprise Connector installation process will not modify your system 
configuration to start the Enterprise Connector service automatically on startup. You need to 
start ZEC manually by sending “./zec -s” each time the server is restarted. If you would 
like to have the Enterprise Connector service start automatically, you must manually modify 
your System V startup script to provide this functionality.

Table 1 • ZEC Command Line Options 

Option Description

-i or 
--daemon-status 

Displays the status of the daemon (running or stopped).

Format  ./zec -i 

-l or 
--license

Displays the running mode (demo or licensed) of ZEC.

Format  ./zec -l 
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-p or --print Sends the specified XML document to the ZEC to be printed to a specific 
printer.

Format  ./zec -p "FileName" "PrinterName" 

If ZEC is not running when users submit print requests, the print requests are 
cached in a file called <install_path>/tmp/zecNoServiceAvail. 
You can restore the print requests after verifying that the ZebraLink Enterprise 
Connector is running. 

Important • Do not attempt to restore the print requests if ZEC is not 
running.

To check the ZEC status, run the following:

%> <install_path>/bin/zec -i

If necessary, start ZEC by running:

%> ./zec -s

To restore the cached print jobs, run the following:

%> cat <install_path>/tmp/zecNoServiceAvail > <install_path>/bin/zecPipe

-r or 
--refresh-daemon-settings

Forces the running daemon to reread the application settings.

Format  ./zec -r 

-s or 
--start-daemon

Starts ZEC as a daemon.

Format  ./zec -s 

Table 1 • ZEC Command Line Options (Continued)

Option Description
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-t or 
--token

Generates a token file to be used for product licensing

For more information about this option, see Licensing ZEC on page 16.

Format  
./zec -t "customerName" "receiptNumber" ["ipAddress" "hostName"]

-v or 
--version

Returns the ZEC version number.

Format  ./zec -v 

-x or 
--stop-daemon

Stops the running ZEC daemon.

Format  ./zec -x

Table 1 • ZEC Command Line Options (Continued)

Option Description
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Printing a Test Label

After installing ZEC, print a test label from the zplrepository directory to verify that you 
can print from the application.

To print a test label, complete these steps:

1. If it is not already installed, install and configure the CUPS driver. See Configure the 
CUPS Driver on page 101 for more information.

2. Make sure that your printer is loaded with media and ribbon (if required) and that the 
printer power is on (I).

3. Start ZEC by running the following command from the command line.

%> ./zec -s 

4. Enter the following command to print the Shipping.xml sample data. Substitute the name 
of the printer as defined in the CUPS driver.

%> ./zec -p "xmlreports/Shipping.zpl" "YourPrinterName"

5. Did the test label print?

If… Then…

Yes Continue with the next section.

No a. Verify that your printer is turned on and loaded correctly with media and 
ribbon.

b. Confirm that the data light on the printer flashes when you send the print 
job. If the data light does not flash, the printer is not receiving data. Check 
the data connections.

c. Check that the CUPS driver is configured correctly. See Configure the 
CUPS Driver on page 101.

d. If the printers is connected to your network using a ZebraNet print server, 
confirm that the printer is online. There are two ways to do this:
• Using a web browser, go to the printer’s IP address to view the printer’s 

web page. The printer’s status is displayed there.
• Using a terminal emulation program or the command line, connect to the 

printer via telnet, and send the ZPL command ~WC. A printer 
configuration label should print. 

The following is an example of a command to create a raw telnet 
connection to a printer at IP address 10.3.5.66:
   telnet 10.3.5.66 9100
After you are connected to the printer, send the ~WC command.
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Configuring ZEC

To configure ZEC for use, you must modify the settings.ini file and the 
ReportInfo.ini file in the <install_path>/bin directory to match your 
requirements.

settings.ini

ZEC installs a default version of the settings.ini file that you may need to edit to match 
your application. If an entry in the file is not present, ZEC uses the default value. If you delete 
the settings.ini file, ZEC regenerates the file with default settings.

Important • After you edit the settings.ini file, you must issue the refresh command 
(./zec -r) for ZEC to reload the file.

Table 2 • Settings to Configure in the settings.ini File

Setting Default Value Description

zplrepository zplrepository The directory where ZEC looks for ZPL template files.

logging on Turns error logging on and off. The sysLog.txt file is 
saved to the ./logging directory.

zpllogging off Turns on and off the option of saving ZPL created by 
ZEC.

Note • Using this feature causes the zplLog 
directory to retain every label sent to the print 
queue, which could potentially consume a large 
amount of disk space.

zpllogdir logging/zplLog The directory where ZPL files are logged.

xsl xsl The directory where ZEC looks for XSL transform files.
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ReportInfo.ini

ZEC uses the ReportInfo.ini file to map incoming XML data to specific ZPL templates 
and optional XSL processing files.

You must make an entry in the ReportInfo.ini file for each root node that will be used in 
the incoming XML data stream. This configuration step is critical to ensure proper operation.  
Without appropriate entries in the ReportInfo.ini file, ZEC will not perform the desired 
data transformations on incoming XML data.

rootNode = templateFilename.zpl, repeatNode [, xslFilename.xsl] 

Multiple root node definitions may be mapped to a single ZPL template, but each root node 
definition may only be specified once.

Example • This example shows the entry to make in the ReportInfo.ini file if you 
have saved a ZPL template file named AddressLabel.zpl into the zplrepository 
directory.

"SHIP_TO_RECORD_SET = AddressLabel.zpl, RECORD"

This would allow ZEC to match the SHIP_TO_RECORD_SET root node with the 
AddressLabel.zpl template and cause one label to be printed for each RECORD node 
that it found in the XML data. In the following sample XML, two RECORD nodes would 
result in two labels being printed.

<?xml version="1.0" encoding="UTF-8" ?>
<SHIP_TO_RECORD_SET>
   <FROM_NAME>Zebra Technologies</FROM_NAME>
   <FROM_STREET>333 Corporate Woods Pkwy</FROM_STREET>
   <FROM_CITYSTATEZIP>Vernon Hills, IL 60061 
   </FROM_CITYSTATEZIP>
   <RECORD>
       <TO_NAME>Acme Processing</TO_NAME>
       <TO_STREET>1280 Industrial Ave</TO_STREET>
       <TO_CITYSTATEZIP>Planesville, IL 60046 
       </TO_CITYSTATEZIP>
   </RECORD>
   <RECORD>
       <TO_NAME>Omni Corporate Packaging</TO_NAME>
       <TO_STREET>46 Delta Street</TO_STREET>
       <TO_CITYSTATEZIP>Detroit, MI 48226 
       </TO_CITYSTATEZIP>
   </RECORD>
</SHIP_TO_RECORD_SET>
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Notes • ___________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________
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3
ZebraDesigner for XML
The ZebraDesigner for XML software is a labeling software product that brings a complete bar 
code printing solution to desktop users. ZebraDesigner for XML offers an easy-to-use 
interface and meets any label design and printing requirement for efficient label printing 
solutions to users in retail, logistics, health care, chemical, automotive, and other industries.

ZebraDesigner for XML can be used with the following 32-bit Microsoft Windows® operating 
systems: Windows 2000, Windows XP, and Windows Server 2003. 

ZebraDesigner for XML is used to design ZPL template files. Exported templates are 
uploaded to the ZebraLink Enterprise Connector’s ZPL Repository for processing during 
printing.
09/29/2011 ZebraLink™ Enterprise Connector User Guide P1006951-002 A



ZebraDesigner for XML
Label Design Exercise

26
Label Design Exercise 

In this chapter, you will learn how to add a printer, design and export label formats, and create 
variables with ZebraDesigner for XML, which will create the ZPL files. In the following 
example, we are using a Zebra 110XiIIIPlus thermal printer and a ZebraDesigner for XML 
printer driver.

This exercise is hands-on, so you will need to have ZebraDesigner for XML installed before 
you continue.

You will learn how to design a label with fixed and variable objects following these simple 
steps: 

1. Add the Printer driver in ZebraDesigner for XML.

2. Create a basic label.

3. Create variables within the label design.

4. Preview the label on the screen and print a test label.

5. Save and export the label.

The simple label that you will design will look similar to this:
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Add the Printer Driver

1. Select Start > Programs > ZebraDesigner for XML > Add Printer.

The Add Printer wizard appears.

2. Click Next.

The Select Printer window appears.

3. Select the desired printer driver to install.
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4. Click Next.

The Printer Options window appears.

5. If the printer is connected to your computer, select the port to which the printer is 
connected.

6. Click Finish.

The printer driver is installed on your computer.
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Create a Basic Label

Starting with a new 3x2-inch blank label format, you will redesign the label shown in Figure 2. 
This label format will used fixed objects and variable objects, which get values from different 
sources.

Figure 2 • Sample Label to Recreate

In this section, you will:

• Place objects on a label.

• Link objects to variables.

• Preview the label on the screen.
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1. Select Start > Programs > ZebraDesigner for XML > Label Design.

ZebraDesigner opens, and the Welcome Wizard screen appears.

2. Select Create a New Label.

3. Click Finish.

The Label Setup Wizard prompts for the printer to use to create the label.

4. From the drop-down list, select the printer that you just installed.
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5. Click Next. 

The Select Stock window appears. 

6. Click Next to continue.

The printer prompts for page size.

This page provides two ways to enter the page size for your labels:

• Automatically set from label dimensions: ZebraDesigner for XML and 
ZebraDesigner printer drivers automatically size the label dimensions. 

• Select a page size: Allows you to manually define the page size. 
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7. Click Select page size.

ZebraDesigner prompts for the page size (not necessarily the same as the label size).

8. Click Next.

ZebraDesigner prompts for the label layout.

This page provides two ways to change the orientation of the label. Look at the screen and 
printer layouts to see how the label will be printed from the printer relative to how it looks 
on the screen.

• Orientation: Changes the label orientation from portrait (vertical) to landscape 
(horizontal) if necessary.

• Print direction: The Rotated option rotates the label 180 degrees during printing.
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9. Click Next.

ZebraDesigner prompts for the label dimensions (not necessarily the same as page size).

This page provides ways to specify assorted label dimensions:

• Width, height: Defines the label dimensions. This example uses a 3x2-inch format. 

• Margins: Defines the label margins. Leave these values at 0.0.

• Rows, columns: Defines the number of labels in horizontal and vertical directions. 
ZEC supports the use of one row and column. 

• Gaps: Defines the gap between the labels. Leave this value at 0.0.

• Unit of measure: If necessary, change the unit of measure. 

10. Set the label width to 3.0 and the label height to 2.0.

Note • Define gaps only if you change the rows and columns options. If you have 
rolls of labels, the gaps between the labels are auto-identified by the gap sensor in the 
printer.
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11. Click Next.

ZebraDesigner for XML prompts for scripts to add additional ZPL code to the label 
template that it will create.

When necessary, use this dialog box to define custom printer commands and include them 
in the printer stream data. Normally, ZebraDesigner for XML processes your label file and 
exports the appropriate printer commands to the printer.

• Use Header Script: This option sends custom scripts to the printer ahead of the label 
data. 

• Use Footer Script: This option sends the custom script to the printer after the label 
data.

12. Click Finish to close the Label Setup Wizard.

ZebraDesigner displays the label that you created.
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To print labels in which the data changes for each label (such as the Ship To address on a 
mailing label), you need to accommodate for the changing data. ZebraDesigner for XML can 
be used to format labels this way using variable fields. 

• Variable fields can be used with text and bar code objects. 

• The name of the variable field must be specified in the template.

• Sample data for the variable fields must be provided before the label can be exported.

Examples of Defined Variables

Enterprise Connector will only recognize variables that are delimited with $$. For example, 
the variable PART_NUMBER must be defined as $$PART_NUMBER$$.

Important • Case is significant. The variable $$PART_NUMBER$$ will be treated as a 
different variable than $$part_number$$. Additionally, the XML tags sent from 
Oracle BI Publisher must match the variables used in the label template.

The following is a sample XML report. Note the XML tag <PART_NUMBER>.

In a label in ZebraDesigner for XML, the corresponding variable PART_NUMBER is 
enclosed by $$ so that ZEC can recognize that this is variable data.

<IDTAGCARD>
   <RECORD>
      <PART_NUMBER>110-201-0000</PART_NUMBER>
   </RECORD>
</IDTAGCARD>
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Create a Single-Line Variable

As the name suggests, you can use a single-line variable in one line of text on the label. To 
create a single-line variable on your label, do the following: 

1. If it is not already selected, select View > Toolbars > Variable.

The Variable Toolbar displays.

2. In the Variable Toolbar, click the Variable Wizard button. 

The Variable Wizard prompts for the variable name. 
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3. Enter the name of the variable. Use the variable descriptive name from Oracle BI 
Publisher, and include the $$ delimeter.

4. Click Next.

The Variable Wizard prompts for sample data.

5. Replace the word “Sample” with a short string of letters or numbers that is representative 
of the actual data to be used at print time. When you link your variable to the label object, 
the sample data will be used for the contents of the object. The sample data is shown 
during label design only. In this example, a sample part number was substituted for the 
default word “Sample.”

Important • The Oracle BI Publisher XML tags and the label format variables must 
match.
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6. If desired, enter additional ZPL to be added to the label format. This step is optional and 
should only be done when required by the specific application.

7. Click Finish. 

The text cursor appears.

8. Click in the upper-left corner of the label in the ZebraDesigner for XML window.

The Text Wizard prompts for the variable to be used.

9. Select the variable that you just created.
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10. Click Finish. 

ZebraDesigner for XML places the single-line variable at the location where you clicked.

Create a Bar Code

1. In ZebraDesigner for XML, select Object > Bar code.

The bar code cursor appears.

2. On the label in the ZebraDesigner for XML window, click below the number created in 
the previous exercise.

The Bar Code Object window appears.

3. Select Variable bar code data.
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4. Click Next.

The Variable Field Type window appears.

5. Click Next.

The Variable Field Selection window appears.
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6. Select the variable that you created in the previous exercise.

7. Click Finish.

ZebraDesigner for XML places the bar code at the location where you clicked.

8. Click on the bar code to select it. Then right-click on the bar code, and select Bar Code 
Properties.

Note • The bar code appears in red if it does not fit on the label at the location where you 
clicked. If this happens, click on the bar code and drag it fully onto the label, resizing it if 
necessary.
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9. Set the bar code type as Code 128.

10. On the Human Readable tab, select Below bar code.

11. Click OK.
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12. Select View > Data.

The label should look similar to the following:
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Save the Label Template and Export It to a File

Now that you have completed your label design, you need to save your label format, then 
export it to a template file. 

1. Select File > Save As.

2. Select the desired location to save the label format.

3. Give the label format the name IDTAGCARD.

4. Click Save.

5. Select File > Export to Printer.

A warning message appears because ZebraDesigner for XML only allows the file name to 
be eight characters long.

6. Click OK.

The file name is truncated to eight characters: IDTAGCAR. The XML Format Generation 
Wizard prompts for a template file name.
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7. Click Next.

The XML Format Generation Wizard prompts for test XML file settings.

8. Select No to send ZPL file only to a selected folder. 

9. Click Next.

The XML Format Generation Wizard prompts for a file destination.

10. Select Send to File.
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11. Click Next.

The XML Format Generation Wizard prompts for a destination path.

12. Select a location on your computer to save the template file.

13. Click Next.

The XML Format Generation Wizard saves the label format to template file.

14. Click OK.

15. Use Windows Explorer to rename the template file to IDTAGCARD.zpl.

16. Load the IDTAGCARD.zpl file into the ZEC environment.
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Upload ZPL Template Files

For ZEC to be able to transform incoming XML data into printable ZPL, the ZPL templates 
that you create must be uploaded to the ZebraLink Enterprise Connector ZPL repository on the 
server. 

The default ZPL repository directory is <install_path>/zplrepository. To change 
the location of the ZPL repository, see settings.ini on page 22.

Altering ZebraDesigner for XML Variable Creation

Enterprise Connector only recognizes variables that are delimited with $$. For example, 
PART_NUMBER must be defined as $$PART_NUMBER$$. 

You can alter ZebraDesigner for XML so that it automatically displays the $$ characters as 
new variables are being created. In the installation directory for the program 
(C:\Program Files\ZebraDesigner for XML\Bin by default) there is a file 
called setup.ini. In this file there are two entries:

VariableLeftTagCharacter=

VariableRightTagCharacter=

Change these to read:

VariableLeftTagCharacter=$$

VariableRightTagCharacter=$$

and save the file. Do not change any other entries. 
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Notes • ___________________________________________________________________ 
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__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 

__________________________________________________________________________ 
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ZebraNet Bridge Enterprise 
ZebraNet Bridge Enterprise is a centralized printer management application for Zebra printers. 
ZebraNet Bridge Enterprise provides real-time monitoring and configuration of your 
ZebraLink-enabled printers and ZebraNet print servers in a single, easy-to- use application. 
With ZebraNet Bridge Enterprise, you can configure Zebra printers; deploy fonts, printer 
firmware, and graphics to individual printers; and manage from a central repository.
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ZebraNet Bridge Overview

ZebraNet Bridge Enterprise remotely configures and monitors ZebraLink-enabled printers and 
ZebraNet print servers in real time. Core functions include:

• Automatic printer discovery across the enterprise network

• Dynamic group management

• Heartbeat monitoring and status indicators

• Viewable and changeable printer and print server settings

• Easy firmware, font, and file downloading

• Configuration broadcast

• Critical alert management

• Visual alerts management

• Printer profiles

• Maintenance management

Components

This section provides information about ZebraNet Bridge Enterprise.

For a graphical representations of ZebraNet Bridge Enterprise, see the next few graphics. A 
table follows the figures and provides a detailed description of each component. 

6

3

7

5

8

2

1

4

9
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Keys Graphic Element Purpose

1 Search Groups 
window

Allows network searches for Zebra printers with ZebraNet print servers. You 
can conduct searches using:

• local broadcast

• subnet

• directed broadcast

• multicast

• IP Address and range

Content window contains the following:

• Events tab

• Status tab
2 Group Management 

window
Allows you to manage your Zebra printers and print servers. 

Content window contains the following:

• Contents tab

• Events tab

• Status tab

• Summary tab

• Maintenance tab
3 Printer Status icons Visually alert you of potential problems with your printer or print server. The 

application heartbeat updates the status icon. The default interval is every 5 
minutes. 
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4 Resource 
Management 
window

Allows you to copy:

• objects

• firmware

• fonts

• graphics

• files 
to printers in the Group Management window. 

Important • Ensure that files in the Resource Management window 
are in the printer’s native format. 

Content window contains the following:

• Contents tab
5 Profile Management 

window
Allows you to store printer configurations offline. This capability speeds 
recovery from printer failure. Acts as a golden printer to broadcast 
configurations (settings and files) to printers across your network. 

6 Content window Allows you to access these tabs:

• Contents tab — use to view and change settings. 

• Events tab — use to monitor current alerts.

• Status tab

• Quick Status Panel — provides a high-level status of a given print 
server. 

• Detailed Status Panel — when you select Refresh, provides you with 
a detailed status of a given printer.

• Port Status Panel — when you select Refresh, provides current status 
of network ports on the print server.

• Summary tab — use to simultaneously view the status of all printers in the 
Group Management window.

• Visual Alerts tab — use to view a graphical representation of your printer 
network.

• Maintenance tab — use to view the current counter values.
7 System Bar Allows you to check the system status. The system bar consists of:

• Alert bar

• Progress bar
8 Alert Bar Displays the latest alert messages that you have not viewed. 
9 Progress Bar Displays when the Task List dialog box is running in the background. 
10 Task List window Displays the tasks performed on Zebra printers via your network. (For 

example, refresh a printer, download a file, search.) 

Keys Graphic Element Purpose
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Menu and Toolbar Navigation

ZebraNet Bridge Enterprise offers menu bar, toolbar, and right-click functions and navigation. 

Menus and Toolbar

This example demonstrates the three navigational methods.

Supported Languages

ZebraNet Bridge Enterprise application and help system language preferences default to the 
local system language. 

These are the languages supported in ZebraNet Bridge Enterprise: 

• English

• German 

• Italian 

• French 

• Spanish 

• Japanese 

• Korean 

• Portuguese (Brazil) 

• Chinese (China) 

• Chinese (Taiwan) 

Example • This example shows you how to create a new search using the menu bar, toolbar, 
and the right-click.

From the menu, select File 
> New > Search. 

From the toolbar, 
click the New 
Search icon.

From the Search 
Group window, 
right-click on 
Searches, select 
New Search.
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ZebraNet Bridge Enterprise Interface

This section helps you understand the graphical user interface (GUI), which includes:

• Search Group window and printer discovery

• Group Management window

• Resource Management window

• Profile Management window

• Task List dialog box

• Multiple User Interface Configurations

• Working with Mobile printers

• Working with Card Printers

Search Group Window and Printer Discovery

The Search Group window allows you to search for printers. The Search Group window is the 
easiest way to find Zebra printers on your network. When starting out with ZebraNet Bridge, 
this is the first application window you will use.

Search groups update dynamically. Group members depend on which printers the application 
finds on the network. For more details, see Search Group Window and Printer Discovery 
on page 68.

Group Management Window

The Group Management window allows you to manage single printers and printer groups. To 
help you manage your Zebra printer network, you can dynamically group similar printers. Or 
you can group printers by location. To perform printer management tasks, use the Group 
Management window. For more details, see Group Management Window on page 74.

Resource Management Window 

The Resource Management window is a storehouse for printer firmware, label formats, 
graphics, and fonts. Files in the Resource Management window must be supported ZPL file 
formats. You can copy files from the Resources window and paste them to selected printers. 
You will find the printers in the Group Management window. For more details, see Group 
Management Window on page 74.

Profile Management Window 

The Profile Management window provides you with the ability to store printer configurations, 
or profiles. Golden printer configurations can be stored for broadcast to new printers, 
significantly speeding printer set up time. In addition, should a critical printer fail, it can be 
replaced and quickly put into service by downloading the profile across the network.
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Task List Dialog Box 

The Task List dialog box identifies tasks and provides a progress bar for each task. The 
progress bar shows the current status of the task. All application requests to the printer are 
monitored by the Task List dialog box.

Multiple User Interface Configurations

ZebraNet Bridge Enterprise supports multiple user interface configurations. This is useful for 
managing large groups of printers in various configurations. For instance, you may want a 
different application configuration for each department or location.

Working with Mobile Printers 

Select mobile printers may be managed with ZebraLink™ Enterprise Connector, however, 
there are several inherent differences in how mobile printers work with the application. These 
differences are outlined below:

Search Window

Zebra’s mobile printers do not respond to discovery requests. Mobile printers will not be 
included in the results of search groups in the Search window.

Group Management Window

Zebra mobile printers may be added to groups within the Group Management window by 
using the Add Printer feature.

Management of mobile printers in the Group Management window is accomplished similarly 
to management of stationary printers. However, the available options for mobile printers will 
vary from those found with stationary Zebra printers. For example, mobile printers do not have 
Alerts.

Status Icons

Because mobile printers do not respond to discovery requests, status icons for mobile printers 
will always have a white background.

Events Tab

Because mobile printers do not have alerts, the Events tab will not display messages when you 
select a mobile printer.

This feature is available only in the ZebraNet Bridge Enterprise licensed version.
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Status Tab

Mobile printers do not have an internal print server. The Status tab of a mobile printer does not 
display Quick Status. Request Detailed Status or Port Status by clicking Refresh.

Summary Tab

Because mobile printers do not respond to discovery requests, status icons for mobile printers 
in the Summary tab will always have a white background. 

Visual Alerts

Because mobile printers do not have alerts, the Visual Alerts tab will not display alerts.

Maintenance Tab

The Maintenance tab is for use with printers that offer ZPL-based odometers. 

Working with Card Printers 

Select card printers may be managed with ZebraLink™ Enterprise Connector, however, there 
are several inherent differences in how card printers work with the application. These 
differences are outlined below:

Group Management Window

Management of card printers in the Group Management window is accomplished similarly to 
management of stationary printers. However, card printer settings may not be viewed and 
changed in the Group Management Window. Print server settings and alerts are available. 

Profile Management

Profiles may be created for Zebra card printers, however, only the print server settings will be 
included in the printers profile. 

Events Tab

Print server alerts may be received and displayed in the events tab. Card printers do not 
support printer alerts.

Status Tab

Quick status and Port status panes will display status similar to stationary printers. The 
Detailed Status pane, upon refresh will display limited card printer status information.
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Visual Alerts

Zebra card printers may be included in visual alerts, however, only print server alerts are 
available and displayed. 

Maintenance Tab

The Maintenance tab is for use with printers that offer ZPL-based odometers. 
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Set System Preferences

Using System Settings, you can control how ZebraNet Bridge works in your network 
environment. By using the Printer Display and View Filter - Events settings you can select 
what displays within the application. Configure these settings from Menu > Preferences. 

• Event notification

• System heartbeat

• Printer display options

• Discovery options

• View filter events

• Alert options

• Maintenance options

Main Settings Tab

The System Settings dialog box shows the Main Settings tab.

Event Notification

If the application is running minimized and captures alerts, ZebraNet Bridge visually notifies 
you. Event notification allows you to monitor printers that have a specific event type, such as 
Urgent.
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To receive visual notices when printers capture alerts:

1. From the menu bar, select Preferences > System Settings.

The Main Settings tab opens.

2. From the When an event arrives area, click the Force application to be active when the 
event severity is at least list and select the event severity that you need.

Your choices are: Never (default), Info, Warning, Urgent.

3. Click OK.

Note • You can set alert event severity levels in the View Filter - Events tab of the System 
Settings dialog box.
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Program Startup

If you have saved multiple user interface configurations you can specify how you want the 
application to act at startup. For more details, see Multiple User Interface Configurations 
on page 55.

1. From the menu bar, select Preferences >System Settings.

The Main Settings tab opens.

2. What default configuration do you want to use?

System Heartbeat

The System Heartbeat controls how often the printers status icon and quick status update. The 
default interval is five minutes.

To assign a system heartbeat interval:

1. From the menu bar, select Preferences > System Settings.

The Main Settings tab opens.

2. Decide the time (in minutes) that you want ZebraNet Bridge to wait between heartbeat 
pulses; in the System Heartbeat Interval area, type in the time.

3. When you are finished, click OK.

This feature is available only in the ZebraNet Bridge Enterprise licensed version.

If… Then…

you want to use the last used 
configuration

At the program startup area, enable Load 
last used configuration check box.

you want to select the configuration at 
startup

At the program startup area, uncheck the 
Load last used configuration check box. 

Note • Setting the System Heartbeat interval to 0 disables these functions:

• The system heartbeat

• Automatic update of status icons

• Quick status functions
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Printer Options Tab

The System Settings dialog box shows the Printer Options tab.

Printer Display Options

ZebraNet Bridge allows you to customize your printer view. The default setting for displaying 
printer options is IP address. Selections include:

• IP Address

• Host Name

• IP Address (Host Name)

• Host Name (IP Address) 

To change printer display options:

1. From the menu bar, select Preferences > System Settings. 

2. Select the Printer Options tab. 

The Printer Options tab opens.

3. In the Printer Display Options area, select the desired printer display option.

4. When you are finished, click OK.

Important • Using non-printable or XML characters (<, >, /) in printer system or host names 
can cause undesired results. 
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Printer Resolving

ZebraNet Bridge can resolve printers by IP Address or by Host Name. The default setting 
resolves printers by IP address.

To change printer resolving:

1. From the menu bar, select Preferences > System Settings. 

2. Select the Printer Options tab.

The Printer Options tab opens.

3. In the Printer Resolving area, select the desired printer resolve option.

4. Click OK.

Discovery Options Tab

Your network topography affects the printer discovery process. You can optimize discovery 
options for your networked Zebra printers. Three adjustments ensure detection of Zebra 
printers on your network. ZebraNet Bridge allows you to change:

• Time-out intervals

• Retries for printer discovery

• Heartbeat retries

To change discovery options:

1. From the menu bar, select Preferences > System Settings. 

2. Select the Discovery Options tab.

Note • The recommended method is Resolve by IP Address unless it is not supported by your 
network.
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The Discovery Options tab opens.

3. Change Discovery Options as desired. The options are:

• Timeout Interval in mSec: The time that the application waits for response from a 
printer on your network. The default is 1000 mSec.

• Discovery Retries: The number of requests for response from your network printers. 
The default is 3.

• Discovery Port: The network port that the application uses for discovery requests. 
Your network might use this port for another application. If so, you can change this 
port on your Zebra printers. Then direct the application to the new port. The default is 
4201.

• Heartbeat Retries: The number of retries during a heartbeat request. If your network 
is slow, change the application to retry a number of times. This change ensures 
accurate printer status reports. The default is 0.

4. When you are finished, click OK.
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View Filter – Events Tab 

ZebraNet Bridge allows you to capture TCP and SNMP transmitted printer and print server 
alerts. ZebraNet Bridge also allows you to filter events by event severity.

To change event filter severity levels:

1. From the menu bar, select Preferences > System Settings. 

2. Select the View Filter – Events tab.

The System Settings dialog box opens.

3. Find the events (or printer alerts) you want to use.

4. Select the alert name.

5. In the Severity list, select the desired application severity. 

6. Click OK.

Drop-down options 

Selects all alerts

Selects all 
Urgent alerts

Selects all 
Warning alerts

Deselects all 
alerts 

Selects all 
Informational 
alerts
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Alert Options Tab 

ZebraNet Bridge allows you to configure alert behavior within the applications. 

To change TCP alert listening port:

1. From the menu bar, select Preferences >System Settings > Alert Options. 

The Alert Options tab opens.

2. In Alerts Listening Ports, change the TCP Alert Listing Port value. 

To hide unconfigured printer alerts:

1. From the menu bar, select Preferences > System Settings. 

2. Select the Alert Options tab. 

The Alert Options dialog box opens.

3. In the Alert Display area, click Hide Unconfigured Alerts.

The Notice dialog box opens.

4. To close the Notice dialog box, click OK.

5. To save your system settings changes, click OK.
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To configure visual alert options:

1. From the menu bar, select Preferences > System Settings.

2. Select the Alert Options tab. 

The Alert Options tab opens.

3. In the Flash Alerts by Severity list, select the applicable event severity you want. 

Maintenance Tab

ZebraNet Bridge allows you to set and track various odometers. 

To change threshold options:

1. From the menu bar, select Preferences >System Settings.

2. Select the Maintenance tab. 

The Maintenance tab opens.

3. From the Threshold Unit drop-down, select the desired unit of measure.

4. In the Caution Threshold text box and the Warning Threshold text box, enter a value, and 
then click OK. 
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Example • This example provides a scenario of how you would determine the values for 
Maintenance tab:

You are about to load a new roll of media into a printer and you need to identify how many 
labels come are on the roll. For example, a new roll of 4 in. x 6 in. Z-Select 4000D media 
contains 950 labels. 

1. Multiply the total number of labels by 12 to obtain the total inches (950 x 12 = 5700). 

2. With the total number of labels (in inches) for this roll of media, open ZebraNet Bridge 
and select the Maintenance tab. 

3. Right-click on the printer, select Reset Odometer. The Centimeters and Inches columns 
will reset to 0. 

4. Go to the menu bar in ZebraNet Bridge and select Preferences > System Settings, and 
then select the Maintenance tab.

5. In the Maintenance tab, confirm that the Threshold unit is set to inches. 

6. In the Caution Threshold text box, type 5000. 

7. In the Warning Threshold text box, type 5500. 

8. After the above settings are made, select Refresh Counters. 

After the printers odometer reaches 5000, the Caution icon will appear to the left of the 
printer. Once the printers odometer reaches 5500, the Warning icon will appear.

Warning icon
Caution icon
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Search Group Window and Printer Discovery

Discovery allows you to search a variety of ways, including:

• local broadcast

• subnet

• directed broadcast

• multicast

• IP address

Default View

The Search Group window includes a default local search. The local search group is populated 
with printers found in a local subnet broadcast when the application is opened.

Before You Begin

Before you begin you need to decide how you plan to search. 

What kind of search do you want to complete?

Important • Search group names should not include these characters: <, >, /.

If you want to 
search by...

Then...

Local Broadcast Go to Create a Local Broadcast Search Group on page 69.

Subnet Go to Create a Subnet Search Group on page 70.

Directed Broadcast Go to Create a Directed Broadcast Search Group on page 71.

Multicast Go to Create a Multicast Search Group on page 72.

IP Address Go to Create an IP Address Search Group on page 73

Note • You can enter more than one search or search-type within a search group.
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Create a Local Broadcast Search Group 

Local broadcasts send a discovery request to the local broadcast address of 255.255.255.255. 
This request finds printers in the same local network as the requesting computer. 

To perform a local broadcast search group:

1. In the Search Group window, right-click Searches. 

2. Select New. 

The New Search Group dialog box opens.

3. In the Search Group Name text box, type in the search name.

4. Enable the Local Broadcast option button.

5. The Value field is automatically populated. Click Add. 

The Value field is added to Search type.

6. Click OK.

The Task List dialog box shows the task progress. 
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Create a Subnet Search Group 

The subnet search sends a discovery request to each address in the specified subnet. This 
feature is useful for networks that prevent broadcast packets from passing across routers. The 
Subnet search requires you to type in the first three subnet octets. 

To perform a subnet search group:

1. In the Search Group window, right-click Searches. 

2. Select New Search. 

The New Search Group dialog box opens.

3. In the Search Group Name text box, type the search name.

4. Enable the Subnet option button. 

5. In the Value field, type the first three subnet octets followed by an *.

6. Click Add. 

7. Click OK. 

The Task List dialog box shows the task progress.

Example • A request to 192.168.2.* sends a request to: 192.168.2.1 through 
192.168.2.254.
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Create a Directed Broadcast Search Group 

Directed broadcasts send a discovery request to the broadcast address of the specified subnet.

To perform a Directed Broadcast search group:

1. In the Search Group window, right-click Searches. 

2. Select New Search. 

The New Search Group dialog box opens.

3. In the Search Group Name text box, type in the search name.

4. Enable the Directed Broadcast option button.

5. In the Value field, type in the first three subnet octets and then 255.

6. Click Add. 

7. Click OK. 

The Task List dialog box shows the task progress. 

Note • If a broadcast search does not work, the broadcast packets may be disabled across 
routers. Try multicast or subnet search. 

Example • The directed broadcast search requires you to type in the first three subnet octets, 
followed by 255, such as 192.168.2.255.
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Create a Multicast Search Group 

Multicast uses the multicast address to send a discovery address to all Zebra Printers across as 
many routers as the hop count specifies. A multicast search may return a large number of 
printers in some installations.

The Multicast search requires you to type in the number of routers to hop. 

To perform a Multicast search group:

1. In the Search Group window, right-click Searches. 

2. Select New Search. 

The New Search Group dialog box opens:

3. In the Search Group Name text box, type in the search name.

4. Enable the Multicast (Hops) option button.

5. Within the parentheses, in the Value field, type in the number of routers to hop.

6. Click Add.

7. Click OK. 

The Task List dialog box shows the task progress. 

Note • On some routers, this feature may be disabled. See your network administrator to 
determine if a search failure was due to this feature being disabled. 
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Create an IP Address Search Group 

To complete the IP address search, you can enter an IP address or an address range. 

The IP address search avoids sending unnecessary traffic to non-printing devices. 

To perform an IP address search group:

1. In the Search Group window, right-click Searches. 

2. Select New Search. 

The New Search Group dialog box opens.

3. In the Search Group Name text box, type in the search name.

4. Enable the IP Address option button.

5. In the Value field, type in the IP address, or partial address using *.

6. Click Add.

7. Click OK. 

The Task List dialog box shows the task progress. 

Example 1 • To send a discovery request to 10.3.5.20 only, enter: 

10.3.5.20

Example 2 • To send a discovery request to printers in the address range of 10.3.5.20 
through 10.3.5.47, enter:

10.3.5.20-47
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Group Management Window 

The Group Management window allows you to manage single Zebra printers and groups of 
printers. To manage your printer network, you can group printers by type or by location. 
Printers can reside in more than one group. 

Create a Group 

Creating a group allows you to manage groups of printers in one location or folder. 

To create a new group:

1. In the Group Management window, right-click on Groups.

2. Select New > Group. 

The new group folder appears as New Group.

3. Type in a new name for the New Group folder.

4. Press Enter. 

5. If you want to populate your new group, go to Copy Individual Printers to a Group 
on page 75.

Example •  If you wanted manufacturing floor printers in their own subfolder, you could 
rename the new group folder to “Manufacturing.” Naming printers by location or department 
helps you to monitor the designated groups of printers. 
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Copy Search Groups 

To make setting up large groups of printers easier, copy entire search groups to the Group 
Management window.

To copy a search group:

1. In the Group Management window, find the search group that you want to copy. 

2. Right-click on the source search group. 

3. Select Copy.

4. Find the group that you want to paste this group into. 

5. Right-click on the target group. 

6. Select Paste > Group. 

Copy Individual Printers to a Group 

To populate a group with a variety of printers, you can copy individual printers to the group as 
needed. 

To copy and paste printers into a group:

1. In the Search Group or Group Management window, find the source printer that you want 
to copy.

2. Right-click on the source printer. 

3. Select Copy. 

4. In the Group Management window, find the target group that you want the printer copied 
into.

5. Right-click on the group.

6. Select Paste > Copy printer to group. 

7. Repeat step 1 through step 6 until the target group contains all of the printers that you want 
to manage.
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Add Printers 

You can add networked or locally connected printers from the Group Management window. 
You can add a printer to the group folder or to a group subfolder.

To add a networked printer:

1. In the Group Management window, right-click on a group.

2. Select New > Printer.

The Add Printer Wizard dialog box opens.

3. Select Network (IP Address).

Note • For local printers, the heartbeat interval does not update the printer status icon.
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4. Click Next.

The Add Printer Wizard dialog box prompts for an IP address.

5. What type of printer do you wish to add?

6. Click Finish.

The printer is added to the selected group in the Group Management window. 

The next heartbeat interval updates the printer status icon. You may expand the printer 
using the + icon beside the printer IP Address.

If … Then…

You are adding a 
stationary printer

1. Enter the IP address of the printer that you wish to add.

2. From Select PrintServer Type, select the ZebraNet Wired 
and Wireless option box.

3. Enter the port number for the printer. 
Note • The default port for Zebra tabletop and 
desktop printers is port 9100.

You are adding a mobile 
printer

1. Enter the IP address of the printer that you wish to add.

2. From Select PrintServer Type, select the Mobile-802.11b 
option box.

3. Enter the port number for the printer. 
Note • The default port for Zebra mobile printers is 
port 6101.

Note • For local printers, the heartbeat interval does not update the printer status icon.
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To add a local printer:

1. In the Group Management window, right-click on a group.

2. Select New > Printer.

The Add Printer Wizard dialog box opens.

3. Select Local Port (COM, LPT, USB, etc.).

4. Click Next.

The Add Printer Wizard dialog box prompts for the port where your printer is located.

Note • If you have a driver installed on a local port, that port will not be available in the 
list. A message to notify you of unavailable ports displays in the dialog box.
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5. From the list, select the port location of your printer.

6. Click Finish.

In the Group Management window, the selected group contains the new printer. 

If you select… Then…

An LPT or USB port Click Finish.

A COM port The Add Printer Wizard dialog box expands.

a. Adjust COM port settings to match those in use by your PC 
and printer.
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Sort Printers and Groups

This feature allows you to sort by ascending alphabetical and numeric order in the Group 
Management window. 

To sort the items in the Group Management window:

1. In the Group Management window, click Groups.

2. Click the sort button in the Group management window.

The groups and printers sort alphabetically and numerically. 

1 Sort button

1
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Printer Preferences 

You can set up communications preferences for individual printers separately from the 
application preferences using the Printer Preferences function in ZebraNet Bridge Enterprise. 
You can also add individual notes to each printer, such as a firmware upgrade date or other 
printer information.

To set individual printer communication preferences:

1. In the Group Management window, right-click on a printer.

2. Select Preferences. 

3. Click the Advanced tab.

4. Select Communications Settings.

The Add Printer Wizard dialog box opens.

5. Select Network (IP Address). 
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6. Click Next.

The Add Printer Wizard dialog box prompts for the network information.

7. Change the port number. 

8. Click Finish.

To create a printer note:

1. In the Group Management window, right-click on a printer.

2. Select Preferences. 
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3. Click the Notes tab. 

The Printer Preferences dialog box opens.

4. Type notes in the text area.

5. When you are finished, click OK.

Note • The text in the Notes section saves with the application. The application does not 
send this information to the printer.
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Delete Printers/Groups 

From the Group Management window, you can delete printers or groups of printers. 

To delete a printer:

1. From the Group Management window, right-click on a printer.

2. Select Delete. 

The printer that you select is deleted from the group.

3. To delete a group of printers, right-click on the group.

4. Select Delete. 

The group that you select is deleted from the list.

Important • Use this feature carefully. You immediately delete printers and groups from the 
Group Management window. 
P1006951-002 A ZebraLink™ Enterprise Connector User Guide 09/29/2011



85ZebraNet Bridge Enterprise 
Task List Dialog Box
Task List Dialog Box

The Task List dialog box identifies tasks and provides a progress bar for each task. Through the 
Task List, you may control or cancel any task. A task is a request from the application to a 
printer or group of printers.

To cancel a task:

1. In the Task List dialog box, locate the specific task.

2. To the right of the associated progress bar, click Cancel.

To remove a task from the Task List dialog box:

1. In the Task List dialog box, locate the specific task.

2. To the right of the associated progress bar, click Clear.

To clear all tasks from the Task List dialog box:

In the Task List dialog box, click Cleanup.

To open the Task List dialog box:

In the Task List dialog box, select Auto open when a task is added.

To manually launch the Task List window:

In ZebraNet Bridge Enterprise window toolbar, click the Task Manager icon.

Note • If you request a task for a group of printers, the tasks appear separately in the Task 
List for each printer.
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Printer and Print Server Alerts 

Alerts give you the ability to proactively manage your Zebra printer and print server. Suppose 
that the printer or print server has an error. The given device can be configured to send out 
alerts and ZebraNet Bridge writes the alerts to a log file. These alerts notify you of printer or 
print server conditions. 

As soon as ZebraNet Bridge receives an alert, the alert appears in the Events tab. If you have 
not viewed the alert yet in the Events tab, the box in the status bar at the bottom of the 
application shows:

• New alert 

• Alert type 

• Alert severity by color

You can configure ZebraNet Bridge to notify you by blinking the application tab in the task 
bar.

Configuring Printer Alerts 

To set printer alerts, use the following communication protocols:

• Email

• Serial

• SNMP

• TCP

• UDP

• USB

To configure a printer alert:

1. In the Group Management window, expand the printer on which you want to set an alert.

ZebraNet Bridge retrieves the settings from the printer.

2. Select the Alerts subfolder and expand it by clicking on the +.

3. Select the alert that you want to set and expand the alert options by clicking on the +.

4. Select the communication protocol. 

5. Enable Set or Clear in the Contents tab.

Important • ZebraNet Bridge only logs alerts that occur while the application is running.

Note • ZebraNet Bridge Enterprise only monitors and logs printer and print server alerts 
using SNMP on port 162 and TCP. The application allows you to set up other printer and 
print server alerts. 
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6. If applicable, insert the address and port. 

Some settings have a list to choose from. Other settings have a value to change. 

7. To save the settings, right-click on the printer.

8. Select Save. 

A warning confirms that you want to commit to changes.

9. Are you sure that you want to make the changes?

For more details on setting alerts, see the ZPL II Programming Guide. 

View Printer and Print Server Alerts

The Events tab provides a log of printer and print server alerts received by the application. 
Events may be viewed by group or by printer and may be sorted by printer name, IP address, 
date/time received, severity, or trigger. 

To view alerts:

1. In the Group Management window, select a group or printer whose event you want to 
view.

2. In the Contents window, select the Events tab.

3. To sort events by printer name, IP address, date/time received, severity, or trigger, double-
click the column headings. 

If… Then…

No Select No. 

Yes Select Yes. 
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Clear Alerts Log 

When the number of unsolicited alerts increases significantly, alerts may be difficult to view. 
The application might slow when loading the alert log file. 

To clear the alert log:

1. From the menu bar, select Tools > Clear Alert Log.

The Clear Alert Log dialog box opens.

2. Do you wish to save the current alert log file?

The active alert log and the Event tab of the Content window clears.

If… Then…

No Click OK.

Yes Enable the Save Alert Log To File check box and save the file.
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Status Icons 

Status icons in the Group Management Window provide at-a-glance status information about 
your printers and print servers.

Status icons are updated by the application heartbeat. The application heartbeat can be set from 
1 to 120 minutes, or set to off. The default setting is 5 minutes. Turning the application 
heartbeat off will result in the printer icons being white. You can set the application heartbeat 
from the System Settings dialog box in the Preference menu.

Status icons use these color codes:

• Green indicates no errors detected.

• Yellow indicates warning conditions detected.

• Red indicates urgent errors detected.

• White indicates that the printer is not detected by the application. 

Status Tab

The Status tab provides status of your Zebra printers. The status types are:

• Quick Status appears as soon as you select the status tab. It provides a high-level view of 
the print server status and is updated by the application heartbeat.

• Detailed Status is empty when you select the Status tab. When you click Refresh, this 
panel reports printer status. Printer error conditions are displayed with a red background.

• Port Status updates when you click Refresh. This panel includes information on the print 
server ports. 
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To view the status of a printer:

1. From the Group Management window, select a printer that you want to check.

2. In the Content window, click the Status tab. 

The Status tab opens. 

Important • To minimize network traffic, the Detailed Status panel does not update 
automatically. 

When printer port 9100 has an active connection, you cannot update Detailed Status.

Detailed Status 
panel

Refresh 
button
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3. What type of status do you wish to view?

If you want to view… Then…

Print Server Status • In the Quick Status panel, click Refresh. 

The Quick Status updates with the heartbeat of the 
application.

Printer Status • In the Detailed Status panel, click Refresh. 

The Detailed Status panel is updated with selected 
status details from the printer. 

Port Status • In the Port Status panel, click Refresh.
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Summary Tab

The Summary tab provides a print server status summary of all printers in the Group 
Management Window similar to ZebraNet Utilities. Printer and print server settings may not 
be changed in the Summary tab. 

To view a group, in the Group Management window select the group you to view and click on 
the Summary tab. 
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Visual Alerts 

Visual Alerts allow you to view and centrally manage your printers in a graphical 
representation of your network, whether on the manufacturing floor, in a distribution center, 
cross-docking facility, or scattered around the globe in multiple facilities. With the ability to 
drill down through locations to identify trouble printers, you can monitor your top level groups 
and receive visual notification of issues, before they become problems.

Visual Alerts work in concert with Printer Alerts. You can customize the application to your 
company’s needs. 

Default View

Selecting printers and groups in the Group Management window with the Visual Alerts tab 
selected displays the printers, by default. This is considered the starting point for Visual Alerts 
configuration.

Before You Begin

It is recommended that you configure printers in their appropriate management groups in the 
Group Management window before attempting to configure Visual Alerts. By doing so, you 
significantly reduce the time required to configure Visual Alerts. 

Configure Visual Alerts Tab 

It is recommended that you follow these instructions from the top-down for configuration of 
Visual Alerts.

To add a background image to a group:

1. In the Group Management window, select the top level group.

This feature is available only in the ZebraNet Bridge Enterprise licensed version.

Example • If you want to monitor paper out conditions for manufacturing floor printers, you 
could set up the printer alerts for Paper Out using SNMP. The application monitors SNMP 
traps for printer alerts. If the Visual Alerts tab is configured, you are graphically alerted to a 
Paper Out condition for all your manufacturing floor printers. 

Note • The preferred way to configure Visual Alerts is to begin with the top level group in 
the Group Management window, and then move down through the appropriate management 
groups.

Important • It is recommended that you save the graphic files that you intend to use in the 
application’s Resource Management window.
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2. Select the Visual Alerts tab. 

The content of the selected group appears in the upper left-hand corner of the Visual 
Alerts tab in the form of folders for groups and printer icons for printers.

3. Right-click in the group map area of the Visual Alerts tab.

4. Click on Select Background Image.

The Open dialog box opens.

5. Browse to the location of your background graphic file.

6. Select the file.

7. Click Open. 

The graphic is displayed in the group map area of the Visual Alerts tab.

8. Drag and drop the sub-groups (or printers) to the appropriate place in your graphic.

9. In the Group Management window, select a second-level group or double-click on the 
group’s folder in the Visual Alerts tab map area. 

The content of the second-level group appears in the upper left-hand corner of the Visual 
Alerts tab. It shows folders for groups and printer icons for printers.

10. Right-click in the group map area of the Visual Alerts tab.

11. Select Background Image.

The Open dialog box opens.

12. Browse to the location of your second-level background graphic file.

13. Select the file.

14. Click Open. 

The graphic is displayed in the group map area of the Visual Alerts tab.

15. Drag and drop the sub-groups (or printers) to the appropriate place in your graphic.

16. Repeat this process for each sub-group until finished.

Note • The title bar of the Visual Alerts tab contains the name of the selected group in the 
Group Management window. 

Note • Leaving the Visual Alerts tab or moving to another group in the Group Management 
window automatically saves all changes to your Visual Alerts tab group map. 
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Monitor Alerts with the Visual Alerts Tab 

These instructions show the recommended method for monitoring and troubleshooting your 
printers using the Visual Alerts tab. 

Using the Visual Alerts configuration applied in the Configure Visual Alerts tab area of this 
chapter, we will follow an alert received in the VH DC group.

To monitor printers using the Visual Alerts tab:

1. In the Group Management window, select the top level group and select the Visual Alerts 
tab. 

This illustration shows a flashing subgroup.

Note • Selecting the top-level group organizes and presents information for all received 
Visual Alerts, regardless of which management sub-group the printers reside in the Group 
Management Window. If you do not have the Visual Alerts tab open when an alert is 
received an icon appears next to the text on the Visual Alerts tab.

When a printer or print server alert is received by the application, the appropriate 
management sub-group will begin to flash in the Visual Alerts group map area.

1 Flashing subgroup

1

09/29/2011 ZebraLink™ Enterprise Connector User Guide P1006951-002 A



ZebraNet Bridge Enterprise 
Visual Alerts

96
2. Double-click the flashing subgroup. 

The subgroups Visual Alerts group map opens. The printer that received the alert flashes.

This illustration shows a flashing printer.

1 Flashing Printer

1
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3. Double-click the flashing printer. 

The Alert Notification dialog opens next to the printer. Information is displayed the dialog 
box for all received alert(s).

• To clear the alert and stop the flashing printer and sub-group, click Clear Alert(s). 

• To clear printer alerts for all printers, in the upper-right-hand corner of the Visual 
Alerts tab, click Clear All Alerts. 

1 Alert Notification dialog box

1
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4. To troubleshoot printer issues further, look at the printer in the Status tab to determine the 
issue before deploying resources to a remote location. 

The Status tab looks like this:
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Maintenance Tab

The Maintenance tab provides these statuses:

• Printer—The name of the individual printer

• Centimeters—Length in centimeters of media printed since the odometer was last reset

• Inches—Length in inches of media printed since the odometer was last reset

• Non-Resettable cm—Length in centimeters of media printed for the whole life of the 
printer

• Non-Resettable in— Length in inches of media printed for the while life of the printer

• Last Refreshed—Last time the current odometer was refreshed

To view a group, in the Group Management window select the group you to view and click on 
the Maintenance tab. 

This feature is available only in the ZebraNet Bridge Enterprise version.
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Configure the CUPS Driver 
The Common UNIX Printing System™ (CUPS) driver provides the printing layer for UNIX-
based operating systems and is available in most Linux distributions. The ZebraLink 
Enterprise Connector uses CUPS in RAW pass-through mode as the basis for handling print 
jobs from Oracle BI Publisher. For additional information on CUPS, go to 
http://www.cups.org. This chapter details how to configure the CUPS driver for use with ZEC. 
The examples shown here were created using Red Hat. The interface may vary depending on 
the operating system used.

If the CUPS driver is not available, Zebra recommends that you use a Raw or Generic (“pass-
through”) printer driver. The purpose of using this type of driver is to ensure that the data 
coming from ZEC is not altered by the driver.
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Configuration

Follow these steps to configure CUPS for the Enterprise Connector:

1. In Red Hat, select System > Administration > Printing.

The Printer configuration dialog opens.

2. Click New Printer.

The New Printer dialog displays.

3. Give the printer a name to display on the network. A description and location are optional.

4. Click Forward.
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5. Select AppSocket/HP JetDirect, and enter the IP Address of the Zebra printer in the 
Hostname field.

6. Click Forward.

The system prompts for you to select the printer driver.

7. Select Raw as the printer driver.

8. Click Forward.
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9. Verify that Raw is selected.

10. Click Forward.

The system prompts you to confirm adding the new printer with the information shown.
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11. Click Apply to add the printer.

The printer that you added is displayed.

12. If you are finished adding printers, exit the Printer configuration dialog. If you need to add 
more printers, repeat this procedure.
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Configuring and Using 

Oracle BI Publisher
In order to print using ZEC from Oracle BI Publisher, you must install BI Publisher as 
recommended by Oracle. Refer to the Oracle BI Publisher user documentation for information 
on how to build reports, define data types, create report types, and register the reports to the 
Concurrent Program for printing. This section will detail how to configure the Concurrent 
Manager to output XML reports to ZEC.

To use Zebra printers with Oracle BI Publisher and ZEC, the printers should be able to receive 
data via the CUPS driver. For more information on CUPS, see Configure the CUPS Driver 
on page 101.

To use the ZebraLink Enterprise Connector solution, do the following:

• Design and export label templates to a file using the Microsoft Windows-based 
ZebraDesigner for XML label design environment (see ZebraDesigner for XML 
on page 25).

• Upload label templates to the server-based ZEC environment (see Upload ZPL Template 
Files on page 47).

• Configure Oracle to send XML print requests through ZEC. Oracle provides two solutions 
that can be used with ZEC:

• Concurrent Manager for Oracle eBusiness Suite

• Stand-alone Oracle BI Publisher

• Configure the ZEC ReportInfo.ini file to link reports that will be generated from 
Oracle BI Publisher to the label design template files that are stored in the ZEC 
environment (see ReportInfo.ini on page 23).
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Using the Oracle Concurrent Manager

In Oracle Applications, the Oracle Concurrent Manager is used to manage the application’s 
concurrent requests. This can be a single request or batch of requests.  When the Concurrent 
Manager and ZEC are used together, all XML report printing requests are processed through 
the Concurrent Manager, which forwards them to ZEC.

Starting the Concurrent Manager

This section requires the SYSADMIN user or the Oracle Apps DBA to perform 
setup/startup/shutdown/configuration of the Concurrent Manager.

1. Log into the Oracle Application server.

2. Click Apps Logon Links.

The login screen displays.

3. Login as SYSADMIN.
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Configuring the Printer Drivers

The following procedure guides you through the process for configuring the Concurrent 
Manager for use with ZEC.

1. Navigate to the Driver Menu option and open the Printer Driver Window by clicking on 
the Driver Menu.

The Printer Drivers dialog displays.
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2. Configure the Printer Driver as shown. Note that the Argument path is the path where 
ZEC is installed.

Argument = 
<install_path>/bin/zec -p $PROFILES$.FILENAME $PROFILES$.PRINTER

3. Click the Save icon , and then exit the dialog.
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Configuring the Printer Style

1. Select the Style Menu option on the Navigation Menu.

The Print Styles dialog displays.

2. Enter a Style Name, a User Style, a Sequence, and the Layout options.

3. Click the Save icon , and then exit the dialog.
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Configuring the Printer Type

Your company may have various brands of printers. Because ZEC only works with Zebra 
ZPL II printers, Zebra recommends that you use the “Printer Type” field to differentiate Zebra 
printers from other brands.

1. Select Types, and then click Open.

The Printer Types dialog displays.

2. Enter the Type, Description, Style, and Driver Name.

3. Click the Save icon , and then exit the dialog.
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Registering the Printer Driver

The newly created Printer Driver must be registered.

1. Select Register, and then click Open.

The Printers dialog displays.

2. Select the printer.

3. Enter the Type and a Description for the Zebra printer that you are using with Oracle BI 
Publisher. 

4. Click the Save icon , and then exit the dialog.
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Configuring the Concurrent Program Settings

Printing from Oracle BI Publisher using the Concurrent Manager assumes the following:

• ZEC must be installed and running.

• A printer must be installed and configured

• The Oracle Concurrent program must be configured to output XML.

• A ZPL template appropriate to the Oracle report must be created and uploaded to the ZEC 
zplrepository directory.

• The ReportInfo.ini file must be configured appropriately.

This section configures the Concurrent Manager to deliver XML output to ZEC.

1. In the Program menu, select Define, and then click Open

The Concurrent Programs dialog displays.

2. Set the Output Format to XML (required). Note that the values for Columns, Rows, Style, 
and Printer are populated automatically with the settings that were selected in Configuring 
the Printer Style on page 111. 

3. Click the Save icon , and then exit the dialog.
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Standalone Oracle BI Publisher Instance

The Oracle BI Publisher standalone version must be configured to print through ZEC. 

To configure Oracle BI Publisher, complete these steps:

1. Login to Oracle BI Publisher.

login: Administrator

password: your system password

2. Click the Admin tab.

Note • The screen captures shown here are from Oracle BI Publisher version 10.1.3.3.3.
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3. Click Printer under the Delivery heading.

4. Click Add Server.

5. Enter the printer information. 

• Server Name: Enter the name of the printer.

• URI: Enter the name of the printer.

• Filter: Select Custom Filter from the drop-down box.
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• Filter Command: 

  <install_path>/bin/zec -p {infile} <PRINTER_NAME> {outfile} 

      - Replace <install_path> with the location where ZEC is installed.
      - Replace <PRINTER_NAME> with the printer name being assigned.
      For example, assuming a default installation path of /opt/zebra_ec 
      and a printer name of ZebraPrinter, the Filter Command should be:
        /opt/zebra_ec/bin/zec -p {infile} ZebraPrinter {outfile}

6. Click Apply when completed.
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Printing Reports from Standalone Oracle BI Publisher Instance

Printing a report from Oracle BI Publisher assumes the following:

• ZEC must be installed and running (see ZEC Installation and Operation on page 11).

• A printer must be installed and configured (see Configure the CUPS Driver on page 101).

• The Oracle report must be configured to output XML.

• A ZPL template appropriate to the Oracle report must be created and uploaded to the ZEC 
zplrepository directory (see Save the Label Template and Export It to a File 
on page 44).

• The ReportInfo.ini file must be configured appropriately (see ReportInfo.ini on page 23).

EXAMPLE: To print an Oracle report named “Price List,” complete these steps:

1. Select the Price List report item. 

A completed price list report appears. 

2. View the report data as XML.

3. Click Send. 

The Send Report dialog displays.
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4. Select Printer. 

The Destination information displays.

5. Select the desired printer from the Printer drop-down box. 

6. Click Submit. 

A message confirms that the report has been submitted.

7. Click Close.
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Using XSL for Custom 

Applications
Not all XML data streams will be in the appropriate format for use with ZEC. Using XSLT, 
incoming data can be transformed for use with ZEC.

Note • To learn more about XSLT, see http://www.w3.org/Style/XSL/.
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Data Transformation

See Table 3. The column on the left shows XML data that, although valid, cannot be converted 
into ZPL by ZEC. For this XML to be read, it must be transformed via XSLT. The column on 
the right shows the data after it has been transformed by XSLT. The transformed data can then 
be converted into ZPL by ZEC.

Table 3 • XML Transformed by XSLT

Data to be Transformed via XSLT
(shippingRecordSet.xml)

Transformed Data

xml version="1.0" encoding="UTF-8" ?>
-- Generated by Oracle Reports version 6.0.8.27.0 -->
HIP_TO_RECORD_SET>
RECORD>
<variable name="FROM_NAME">Zebra</variable>
<variable name="FROM_STREET">333 Corporate</variable>
<variable name="FROM_CITYSTATEZIP">Vernon Hills, IL 
061</variable>
<variable name="TO_NAME">Acme Processing</variable>
<variable name="TO_STREET">1280 Industrial 
e</variable>
<variable name="TO_CITYSTATEZIP">Planesville, IL 
046</variable>
/RECORD>
RECORD>
<variable name="FROM_NAME">Zebra </variable>
<variable name="FROM_STREET">333 Corporate</variable>
<variable name="FROM_CITYSTATEZIP">Vernon Hills, IL 
061</variable>
<variable name="TO_NAME">Omni Corp 
ckaging</variable>
<variable name="TO_STREET">46 Delta Street</variable>
<variable name="TO_CITYSTATEZIP">Detroit, MI 
226</variable>
/RECORD>
SHIP_TO_RECORD_SET>

<?xml version="1.0" encoding="UTF-8" ?>
<!-- Generated by Oracle Reports version 6.0.8.27.0 --
<SHIP_TO_RECORD_SET>
 <RECORD>
  <FROM_NAME>Zebra</FROM_NAME>
  <FROM_STREET>333 Corporate</FROM_STREET>
  <FROM_CITYSTATEZIP>Vernon Hills, IL 60061 
</FROM_CITYSTATEZIP>
  <TO_NAME>Acme Processing</TO_NAME>
  <TO_STREET>1280 Industrial Ave</TO_STREET>
  <TO_CITYSTATEZIP>Planesville, IL 
60046</TO_CITYSTATEZIP>
 </RECORD>
 <RECORD>
  <FROM_NAME>Zebra</FROM_NAME>
  <FROM_STREET>333 Corporate</FROM_STREET>
  <FROM_CITYSTATEZIP>Vernon Hills, IL 
60061</FROM_CITYSTATEZIP>
  <TO_NAME>Omni Corp Packaging</TO_NAME>
  <TO_STREET>46 Delta Street</TO_STREET>
  <TO_CITYSTATEZIP>Detroit, MI 48226</TO_CITYSTATEZIP>
 </RECORD>
</SHIP_TO_RECORD_SET>
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The transformation described in Table 3 can be achieved using the following XSL structure:

(SHIPTOREPORT.XSL)

<?xml version='1.0' encoding='utf-8'?>
<xsl:stylesheet xmlns:xsl=http://www.w3.org/1999/XSL/Transform version="1.0">
   <xsl:output method="xml"/>
   <xsl:template match="/">
      <SHIP_TO_RECORD_SET>
         <xsl:for-each select="/SHIP_TO_RECORD_SET/RECORD">
            <xsl:element name="{name()}">
               <xsl:for-each select="*">
                  <xsl:element name="{@name}">
                     <xsl:value-of select="."/>
                  </xsl:element>
               </xsl:for-each>
            </xsl:element>
         </xsl:for-each>
      </SHIP_TO_RECORD_SET>
   </xsl:template>
</xsl:stylesheet>

Configuring the ReportInfo.ini File

In order for ZEC to correctly use an XSL transform, the ReportInfo.ini file must be 
edited. For example, to transform the shippingRecordSet.xml file, the following line 
must be added to the ReportInfo.ini file:

"SHIP_TO_RECORD_SET = AddressLabel.zpl, RECORD, SHIPTOREPORT.XSL" 

Where:

• SHIP_TO_RECORD_SET is the Root Node

• AddressLabel.zpl is the ZPL template file (stored in the zplrepository 
directory)

• RECORD is the Repeat Node

• SHIPTOREPORT.XSL is the XSL transform file (stored in the xsl directory) 
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JD Edwards EnterpriseOne
Introduction

The ZebraLink Enterprise Connector (ZEC) has the ability to efficiently interpret and convert 
XML into printable content, which translates into time and cost savings for bar code label 
printing and RFID encoding.

ZEC offers the following benefits:

• Preloaded label formats, which provide the fastest way to start printing bar codes and 
labels without having to know the Zebra Programming Language II (ZPL II®). The 
preloaded label formats support Oracle® JD Edwards EnterpriseOne,Oracle WMS, Oracle 
Retail, Oracle Depot Repair, and Oracle BI Publisher, facilitating XML printing from 
these Oracle applications.

• Label printing from Oracle Applications to Zebra ZPL II printers.

• A simple, convenient interface for printing labels with text, graphics, or bar codes or for 
encoding RFID tags.

• Efficient use of resources by building a single labeling solution that can be used to print 
multiple languages thanks to Unicode support in Zebra printers.

ZEC is supported on the following operating systems:

• Red Hat® Enterprise Linux® ES release 4

• HP-UX™ 11iV1 (B.11.11)

Important • Java Runtime Environment 1.6.x or greater is required. Additional operating 
systems are supported through Zebra Development Services. For additional information on 
operating systems, please send an email to connector@zebra.com.
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Common Sections

For the sections shown in Table 1, the instructions and illustrations are common for all 
installations. At times within this appendix, you will be instructed to refer back to those 
common sections of this user guide.

Note • The information contained in Appendix D is only pertinent to JD Edwards 
EnterpriseOne users or installations.

Table 1 • Common Sections

Chapter Title Page

2 ZEC Installation and Operation  11

2 Licensing ZEC  16

3 ZebraDesigner for XML  25

C Using XSL for Custom Applications  121
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ZEC and Oracle JD Edwards EnterpriseOne BI Publisher

BI Publisher is the XML transformation engine that is shipped with Oracle JD Edwards 
EnterpriseOne. It is Oracle’s solution for accepting data from a variety of sources and 
transforming them into printable data for transmission to the desired output device. ZEC 
works with BI Publisher to transform incoming data into printable label content, allowing 
Oracle System Integrators to leverage BI Publisher for all thermal barcode output print jobs.

The ZebraLink Enterprise Connector printing solution includes the following components:

• ZebraLink Enterprise Connector – is the server-based solution that is run using the Java 
Runtime Environment. ZEC uses XML-formatted data, which allows for easy 
implementation of custom designs and ZPL delivery to any Zebra ZPL II printer.

• ZebraNet™ Bridge Enterprise - a printer management tool for setting alerts, audits and 
configurations. 

• ZebraDesigner™ for XML - a label design software package that gives you the ability to 
create label formats in a GUI environment.

• Zebra printers - ZEC can be used with any ZPL based Zebra printer.

g
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For ZEC installation and operation, see Chapter 2 
on page 11.

Create an NFS Server Share

Create an NFS server share to the /opt/zebra_ec/xmlreports folder. The share must have 
read/write permissions.    See OS documentation. 

ZEC for JD Edwards EnterpriseOne continuously polls the xmlreports folder for new jobs 
ready to be printed. When a report is moved to that directory, ZEC immediately transforms 
that report to the printer’s native formatting language and then sends to the printer. Upon 
printing, the report is removed from the xmlreports folder and a copy is placed in the archive 
folder. In order for this process to take place, the report generator must have access to the 
xmlreports folder on the ZEC server. There are several ways to accomplish this task. For 
transferring from a Windows environment or IBM system i environments, we suggest creating 
a NSF server share between the Windows machine and the ZEC server. Please consult with 
your network administrator for assistance with setting this up.

We recommend using NFSv4 if possible. NFSv4 stands for network file system version 4 and 
is the newest version of NFS. NFSv4 supports new features like strong authentication and 
integrity via Kerberos and SPKM-3, improved performance, safe file caching, lock migration, 
UTF-8, ACLs and better support for Windows file sharing semantics.

There are several guides detailing how to set up NFS. Some recommended websites are:

http://nfs.sourceforge.net/nfs-howto/index.html

http://docs.redhat.com/docs/en-
US/Red_Hat_Enterprise_Linux/6/html/Storage_Administration_Guide/ch-nfs.html 

On Unix/Linux:

1. Using your OS documentation install the tools needed for NFS.

2. Edit /etc/exports. An example of an NFSv4 export will look like this:

3. /opt/zebra_ec/xmlreports    10.1.2.0/24(rw,fsid=0,no_subtree_check,async,no_root_squash)

4. Edit /etc/idmapd.conf. Fill out the "Domain" entry

5. Start the NFS server

On Windows:

1. Open My Computer

2. In the tool bar go to Tools -> Map Network Drive

3. Then follow the Windows wizard to mount your NFS share
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Modifying ZEC Configuration Files

To configure ZEC for use, you must modify the settings.ini file and the ReportInfo.ini file in 
the <install_path>/bin directory to match your requirements.

Settings.ini

ZEC installs a default version of the settings.ini file that you may need to edit to match your 
application. If an entry in the file is not present, ZEC uses the default value. If you delete the 
settings.ini file, ZEC regenerates the file with default settings.

1. Open up your preferred text editor as root or ZEC user (gedit, kwrite, kate, vi, vim, nano, 
emacs, notepad)

2. Navigate to /opt/zebra_ec/bin/

3. Edit the settings.ini

4. Modify the report to contain the following items.

zplrepository=zplrepository

xmlreports=xmlreports

zpllogdir=logging/zplLog

logging=on

zpllogging=on

xsl=xsl

;---------------------------------------------------

;parameters specific to E1 processing

;-----------------------------------------------------

fileMgr=on        ; Turn on processing of files from 
xmlreports directory– required for E1 processing

arch=/tmp         ; Location to archive files 

fileMgrFileNameStartsWith=R     ; Beginning letter of 
file name for processing xml

fileMgrClearDir=on                        ; Move files 
to archive folder specified with setting arch

fileMgrDefaultPrinter=ZEBRA1   ; Default printer if no 
printer is specified in xml

fileMgrJDETrimming=off; Set off by default for most JDE 
formats

5. Save the edited file.

6. Exit text editor.

Important • You can also edit and create these files in a Windows-based text editor and save 
them to the appropriate location.
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7. Login to a shell as root or ZEC user.

8. Stop and Restart ZEC. 

• To stop ZEC Run: %> <install_path>/bin/zec -x

• To restart ZEC Run: %>  <install_path>/bin/zec -s

ReportInfo.ini

ZEC uses the ReportInfo.ini file to map incoming XML data to specific ZPL templates and 
optional XSL processing files. You must make an entry in the ReportInfo.ini file for each root 
node that will be used in the incoming XML data stream. This configuration step is critical to 
ensure proper operation. Without appropriate entries in the ReportInfo.ini file, ZEC will not 
perform the desired data transformations to incoming XML data.

rootNode = templateFilename.zpl, repeatNode [, 
xslFilename.xsl] rootNode = JDE reportname /define 
repeat node

Multiple root node definitions may be mapped to a single ZPL template, but each root node 
definition may only be specified once. 

1. Open up your preferred text editor as root or as the ZEC user.

2. Navigate to /opt/zebra_ec/bin

3. Edit the ReportInfo.ini

4. Modify the report to contain the following items. (NOTE: These are examples only)

e.g. R5500002A = R5500002A.zpl, Label_Print

e.g. R5500100 =R5500100.zpl, 
Item_Location__Item_Master

5. Save the edited file.

6. Exit the text editor.

7. Login to the shell as root or the ZEC user.

8. Stop and Restart ZEC. 

• To stop ZEC Run: <install_path>/bin/zec -x

• To restart ZEC Run: <install_path>/bin/zec -s

Important • You can also edit and create these files in a Windows-based text editor and save 
them to the appropriate location.

Note •  R5500100 = the Root node in the XML, R5500100.zpl = the label format and, 
Item_Location__Item_Master = the repeat node in the XML 
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JDE.ini

Configure JDE.ini to archive BI Publisher documents (See document 816003.1 on 
support.oracle.com)

• [UBE] section 
BipSaveOutputOnFs= 1   ; exports BI Publisher files to directory
BipOutputDirectory= /printouts  ; directory for file export.

JD Edwards EnterpriseOne Report Development

Modify the report defined for your label and add a special variable “zprinter” which is unique 
for the Zebra Enterprise Connector. This variable will be used to specify the Zebra label 
printer.

With [Object Management Workbench] open:

1. Select a report you wish to print. Then click on the edit button. 

2. Select the “Design Tools” tab. 

3. Select the Start Report Design Aid.
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4. Create a report with all the fields that you want. 

On the report you must have a variable with the name “zprinter”. The zprinter variable is 
required to allow you to specify which printer the label will be printed to. Custom code 
will be required to populate the “zprinter” variable.

Creating the XSL File Translation template

In order for JD Edwards EnterpriseOne to produce valid XML, an XSL file needs to be 
created. This process can be completed by utilizing text editor. (For more information, see 
Document 964292.1 on support.oracle.com). Zebra also offers a Development Services team 
that can help you create the XSL files.

For Using XSL for Customer Applications, see 
Appendix C on page 121.

Important • To specify a Zebra printer, create a variable and name it “zprinter”. Use 
programming logic to set this variable to the desired Zebra Printer.

Important • Do not have a label associated with the variable called “zprinter”. If a label 
must be used with the variable, name the label something other than “zprinter”. “zprinter” 
is a keyword for the Zebra Enterprise Connector.

Important • A printer must be specified within each label or the print output defaults to 
the printer listed in the ReportInfo.ini file.
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BI Publisher Object Definition (P95600)

A new template object needs to be created in JDE Edwards via the BI Publisher Template. In 
this example, a template is going to be created called “XML EXP”.   We will also load the 
Identity.xsl file created earlier. (For general embedded BI Publisher setup and use instructions, 
please refer to Document E14692)

1. Select Add to create a new JD Edwards EnterpriseOne Object to the project.

2. Select “XML Publisher Object” under the “Report Definition Objects” section.

3. Click OK.

4. Fill in the fields for this object. For example: 

Object Name: XML EXP

Object Description: XML Export

Object Type: TS

Product Code: 55

Product System Code: 55

Object Region: US

Object Language: EN
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5. Once all fields are filled in, click OK. 

6. A dialog window will appear. Select the identity.xsl file that was created earlier. 

7. Select a Start and End Date. 

8. Click OK.

BI Publisher Report Definition (P95620)

Define the reports that will be processed by ZEC. Use the Template Name (example “XML 
EXP”) defined with P95600 to specify XML output.

1. Select Add to create a new EnterpriseOne Object to the project.

2. Select “Report Definition” under the “Report Definition Object” section.

3. Click OK.
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4. Fill in the fields for this object.

Report Definition: RD5500002 

Description: EAN Label

Product Code: 55

Product System Code: 55

Source UBE: R5500002 (Assuming the report that was already created is called 
R5500002)

Source Version: TEST

5. In the Table fill in the first row with column Template Name with XML EXP. 

6. Click Next. 

7. Enable the Language by clicking the space under the lock icon in the table at the bottom of 
the page 

8. After you click the icon will change from blank to an checkmark.

9. Click Next.

10. Click End.
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Testing XML Output

1. Open JD Edwards Solution Explorer and type P95620 into the Fast Path box.

2. Click Enter. 

3. Type RD5500002 into the search box above Report Definition Name.

4. Click Find.

5. The software should find your entry. 

6. Select the row that returns.

7. Click Submit on the side bar. 

8. Select Submit on the tool bar. 

9. Click OK.

The report definition RD5500002 should be successfully submitted.   XML output should 
have been written to the /opt/zebra_ec/xmlreports directory on the Zebra Enterprise Connector 
server.  If the Zebra Enterprise Connector is running and configured per the defaults, the XML 
file should be processed and moved to the /tmp directory.

Important • For general embedded BI Publisher setup and use instructions, please refer to 
Document E14692).
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For ZebraDesigner for XML, see Chapter 3 on page 25.

Alternative Configurations

A possible configuration for ZEC and JD Edwards EnterpriseOne is to have both applications 
running on the same server. This reduces the configuration and setup by removing the need for 
an NFS mount. When EnterpriseOne runs batch jobs it can automatically send that job to ZEC 
to run. If you wish to explore this option configure the JDE.ini to archive files to 
/opt/zebra_ec/xmlreports. 

BI Publisher Embedded is an all or nothing method, so you should create separate batch server 
specifically for label printing. For more information about this configuration please contact 
your JD Edwards EnterpriseOne reseller.

For Licensing ZEC, see Chapter 2 on page 11.

Testing Environment

ZebraLink Enterprise Connector Oracle JD Edwards EnterpriseOne Interface

This was tested with E1 9.0 TR 8.98.2 on an iSeries and ZebraLink Enterprise Connecter on 
SUSE Linux 11.
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Troubleshooting
Common ZEC Issues

Java Version

Issue:

• When running zecinstall.bin, it reports that no Java virtual machine can be found.

• Java crashes when attempting to run ZEC.

Solution:

• Verify that the correct version of Java is installed by running “java –version”. It should 
report “Java™ SE Runtime Environment” and not “OpenJDK Runtime Environment”.

• Install Java from Sun’s website (not the open-source version of Java).

Permissions

Issue:

• ·ZEC returns “Invalid Permissions” error.

Solution:

• Verify that the user has rights to run ZEC. The command “ls –ltr” shows the permissions 
for each file. A quick fix is

“chmod 0777 filename” where filename is the target 
file.
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Shell Error

Issue:

• ZEC returns “476: Illegal number: -1”

Solution:

• The user may not have their bash shell configured correctly. Append “bash” to the ZEC 
command – i.e., “bash ./zec –s”.

Shell Error

Issue:

• When trying to print from ZEC, it returns “Error: [report] does not exist.”

Solution:

• You may have to fully qualify the XML file, i.e. “/opt/zebra/xmlreports/LPN.xml” instead 
of “xmlreports/LPN.xml”.

CUPS Mime Types

Issue:

• When trying to print from ZEC, it returns “lp: Unsupported format application/octet-
stream”.

Solution:

• Uncomment the following lines in the following text files by removing the “#” at the 
beginning of the line:

• In /etc/cups/mime.convs, uncomment the line that has “application/octet-stream 
application/vnd.cups-raw 0 -” in it

• In /etc/cups/mime.types, uncomment the line that has “application/octet-stream” in it
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